The Title Goes Here with Each Initial Letter Capitalized

(Use the Microsoft Word template style: Paper Title) or (Use Times New Roman Font: 18 pt,
Bold, Centered)

Author’s Name®® and Author’s Name? 3 b
(Use Times New Roman Font: 14 pt, Centered) (Names should be written in First Name Surname order)

Author Affiliations
(Use the Microsoft Word template style: Author Affiliation) or (Use Times New Roman Font: 10 pt, Italic,
Centered)(if authors share the same affiliation, list the affiliation one time and number accordingly)
'Replace this text with an author s affiliation
(use complete addresses, including country name or code).
2Additional affiliations should be indicated by
superscript numbers 2, 3, etc. as shown above.
3You would list an author’s second affiliation here.

Author Emails
Use superscript letters such as “a)” to indicate the author’s e-mail address below.
Use b), ¢), etc. to indicate e-mail addresses for more than 1 author.
3 Corresponding author: your@emailaddress.xxx
Yanotherauthor@thisaddress.yyy
(Use the Microsoft Wordtemplatestyle: Author Email)or (Use Times New Roman Font: 10 pt, Italic, Centered)

Abstract. To formatyour abstract, use the Microsoft Word template style: Abstract or Use Times New Roman Font: 9 pt,
Indent: left 0.2", Right: 0.2", Justified. Each paper must include an abstract. Begin the abstract with the word “Abstract’
followed by a period in bold font, and then continue with a normal 9-point font.

FIRST, SECOND, AND THIRD LEVEL HEADINGS (FIRST LEVEL HEADING)
(Use the Microsoft Wordtemplate style: Heading 1) or (Use Times New Roman Font: 12 pt, Bold, ALL CAPS,
Centered)

This document was prepared using the AIP Conference Proceedings template for Microsoft Word. It provides a
simple example of a paperand offers guidelines for preparing your article. Here we introduce the paragraph stylesfor
Level 1, Level 2, and Level 3 headings. Please note the following:

¢ Inthistemplate we note whethereach headingis Level 1, 2, or3 — forexample, “(Second Level Heading).”
This is for guidance only; your article headings will, of course, not need those notations.

e Under each heading we have noted which paragraph style to use — for example, “(Use the Microsoft Word
template style: Heading 2).” Again, those notes arenotpart of the headings. Their purpose is to advise you of
the name of the style defined in the AIP Conference Proceedings Word template.

To format a paragraph, use the Microsoft Word template style: Paragraph or Times New Roman Font: 10 pt,
Indent: First line: 0.2", Justified.

How to Apply the AIP Conference Proceedings Template Paragraph Styles (Second Level

Heading)
(Use the Microsoft Word template style: Heading 2) or (Use Times New Roman Font: 12 PT, Bold, Centered)

Here ishowto display a pop-up window from whichto select and apply the AlP Conference Proceedings template
paragraph styles:
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How to Use this Template (Second Level Heading)
(Use the Microsoft Word template style: Heading 2) or (Use Times New Roman Font: 12 PT, Bold, Centered)

You can edit ordeletethe content provided in this template and replace it with the text and figuresof your article.
Please be sure you do not accidentally leave any of this text as part of your paper!

Heading with Each Initial Letter Capitalized (Second Level Heading)
(Use the Microsoft Word template style: Heading 2) or (Use Times New Roman Font: 12 PT, Bold, Centered)

Apart from prepositions and articles, allwords in second and third level headings should have their initial letters
in uppercase. Prepositions are words like “for,” “from,” “with,”“in,” “off,” and articles include words suchas “an,”
‘Ga,,7 “the.”

This is the paragraph spacing that occurs when you use the [ENTER] key.

Heading with Each Initial Letter Capitalized (Third Level Heading)
(Use the Microsoft Word template style: Heading 3) or (Use Times New Roman Font: 10 pt, Italic, Centered)

As with first and second level headings, allwords except prepositions and articles (see above) should appear with
initial letters in uppercase.
This is the paragraph spacing that occurs when you use the [ENTER] key.

MATHEMATICS (FIRST LEVEL HEADING)
(Use the Microsoft Wordtemplate style: Heading 1) or (Use Times New Roman Font: 12 pt, Bold, ALL CAPS,

Centered)

Here we provide some basic advice for formatting your mathematics, but we do not attempt to define detailed
styles or specifications for mathematical typesetting. You should use the standard styles, symbols, and conventions
for the field/discipline you are writing about.

A Note on Microsoft Word’s Equation Editors (Second Level Heading)
(Use the Microsoft Word template style: Heading 2) or (Use Times New Roman Font: 12 PT, Bold, Centered)

From Word 2007 onwards, Microsoft Word provides two “Equation Editors,” which, for ease of reference, we’ll
call “Old Style Equations” and “New Style Equations.”



o “NewStyle Equations” (Word 2007 onwards): With Word 2007 Microsoftintroduced a powerful new built-
in Equation Editor that enables input of sophisticated mathematicstypeset (usually) in the Cambria Math font.
You access it from the Insert menu.

e “Qld Style Equations” (Word 97-Word 2003): For versions of Microsoft Word between Word 97 and Word
2003, mathematical input was created by an add-in: Insertingand editinga “Microsoft Equation 3.0 object,”
typically by Insert = Object and selecting “Microsoft Equation 3.0.”

Newer versions of Microsoft Word (Word 2007 and onwards) still support the original “Old Style Equations”
method of creating mathematics by insertingan equation via Insert = Object and selecting “Microsoft Equation 3.0.”
Whatever method is used, please make sure the equation is clear and readable.

Which Microsoft Word Equation Editor Should | Use? (Second Level Heading)
(Use the Microsoft Word template style: Heading 2) or (Use Times New Roman Font: 12 PT, Bold, Centered)

Due to technical requirements of OpenType font technology, Microsoft Word’s “New Style”” Equation Editor
works only with fonts specially designed for mathematical ty pesetting. Unless you have obtained and configured new
OpenType math fonts, it is highly likely that your installation of Word will use the Cambria Math font for all
mathematics created with the “New Style” editor. Using the Cambria Math font for mathematics and Times Roman
foryourtext will cause a mismatchin the visual appearance of yourarticle, so, for consistency, we preferauthors to
use the “Old Style” Equation Editor because it is straightforward to amend the size/style of the fonts it uses.

Formatting and Inserting Equations (Second Level Heading)
(Use the Microsoft Word template style: Heading 2) or (Use Times New Roman Font: 12 PT, Bold, Centered)

Equations should be centered with equation numbers on the right-hand side (flush right). Achieving a pleasing
layout of equations can be tricky in Microsoft Word, so here are some tips. You can either:

1. Copy, paste, and edit the sample equation provided (recommended), or

2. Manually insert an equation and equation number

Copy, Paste, and Edit a Sample Equation (Third Level Heading)
(Use the Microsoft Word template style: Heading 3) or (Use Times New Roman Font: 10 pt, Italic, Centered)

To use this “Old Style Equation” as a “template,” highlight the entire line, then use cut and paste to the new
location. Note that the equation number will automatically update (increment).

M = SAm, cos, diR] [F]

Wy

=SAm, cos® (1)

Manually Inserting an Equation and Equation Number (Third Level Heading)
(Use the Microsoft Word template style: Heading 3) or (Use Times New Roman Font: 10 pt, Italic, Centered)

If you prefer to manually insert and number equations, follow this step-by-step guide:
1. Makesureyoucan see “hidden characters” by switching on “show invisibles” from the Home menu (it looks

like this: ). Thisallows you to see paragraph markers () and tab characters (), which are usually hidden

from view.

Create a blank paragraph by pressing [ENTER].

3. Formatyour new blank paragraph by applying the Microsoft Word template style: Equation. The Equation
paragraphstyle setsupthe tabs so thatyou can center the equation and have an equation number appear at the
right.

4. Place your cursor at the start of your new paragraph and press the [TAB] key twice.

5. Placeyourcursorbetweenthe tab characters (<) and insert your equation using Insert = Object = Microsoft
Equation 3.0.

N



6. Toaddanequation number, place yourcursorat theend of the paragraph (just before the paragraph markers
(1) and after the second tab character (3)).
7. On the Insert tab, in the Text group, click Quick Parts and then click Field:
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9. From the list of Field Names on the left of the dialog box, select ListNum.
10. From the list of Field properties ontheright, select the “Equations” List name and click OK. You should now
see an equation number in parentheses: e.g., (3).

OTHER SPECIFICATIONS (FIRST LEVEL HEADING)
(Use the Microsoft Wordtemplate style: Heading 1) or (Use Times New Roman Font: 12 pt, Bold, ALL CAPS,
Centered)

Figures, tables, and equations must be inserted in the text and may not be grouped at the end of the paper.
Important: Amiscount of figures, tables, or equations may result in revisions. Please double check the numbering of
these elements before you submit your paper to your proceedings editor.

Figures (Second Level Heading)
(Use the Microsoft Word template style: Heading 2) or (Use Times New Roman Font: 12 PT, Bold, Centered)

Ifyou need to arrange many figures, a good tip is to place themin a table, which gives you additional control of
the layout. Leave a line spacebetween your figure and any text aboveit, and thefigure description and any text below
it, like this one:



relative miensy (arb. unils)

20 40 18] 80 100 120 140 160
Aumber of carkon atoms

(a) (b)

FIGURE 1. To formata figure caption, use the Microsoft Word template style: Figure Caption or Times New Roman Font: 9 pt,
Centered. The text “FIGURE 1,” which labels the caption, should be bold and in upper case. If figures have more than one part,
each part should be labeled (a), (b), etc. Using a table, as in the above example, helps you control the layout

Citeall figures in the text in consecutive order. The word “Figure” should be spelled out if it is the first word of
the sentence and abbreviated as “Fig.” elsewhere in the text. Place the figures as close as possible to their first mention
in the text at the top or bottom of the page with the figure caption positioned below, all centered. Figures must be
inserted in the text and may not follow the Reference section.

Color Figures (Third Level Heading)
(Use the Microsoft Word template style: Heading 3) or (Times New Roman Font: 10 pt, Italic, Centered)

Authors are welcome to use color figures within their article. Foronline publication, there are no costs added for
color figures. However, for printed proceedings (if requested by your conference organizer), there is an additional
cost. Please consult directly with your conference organizer. If your conference organizer has asked AlIP Publishing
to produce printed copies (many ask AIP Publishing for online-only publication), then all figures will be printed in
black-and-white unlessyou makespecific arrangements with your organizer(s) to include color figures in your article
and pay to them the associated fee(s) they request. We advise that many color figures can be printed in black-and-
white with no loss of information; however, some figures do lose information when reproduced in black-and-white.
Check your figure legends carefully and, if your figures are to be printed in black-and-white, remove from your
text/descriptions any references to color.

Tables (Second Level Heading)
(Use the Microsoft Word template style: Heading 2) or (Use Times New Roman Font: 12 PT, Bold, Centered)

Due to the wide range and complexity of tables, we simply offeranexample for guidance. Please follow the style
for table (and figure) captions.

TABLE 1. To format a table caption, use the Microsoft Word template style: Table Caption. The text
“TABLE 1,” which labels the caption, should be bold and all letters capitalized. Center this text above the
Table. Tables should have top and bottom rules, and a rule separating the column heads from the rest of the table

only.
Column Header Goes Here Column Header Goes Here Column Header Goes Here
Row Name Here X X
Row Name Here X X

Row Name Here X X




FINAL KEY POINTS TO CONSIDER (FIRST LEVEL HEADING)
(Use the Microsoft Wordtemplate style: Heading 1) or (Use Times New Roman Font: 12 pt, Bold, ALL CAPS,

Centered)
Here are the main points you needto follow (the AlP author template package contains comprehensive guidance):

Write and prepare your article using the AIP Conference Proceedings template.
Create a PDF file of your paper (making sure to embed all fonts).

e Send the following items to your conference organizer:
o  PDF file of your paper

o  (Ifit applies) Copies of any permissions to re-use copyrighted materials in your article (e.g., figures
from books/journals)

Font Embedding (Second Level Heading)
(Use the Microsoft Word template style: Heading 2) or (Use Times New Roman Font: 12 PT, Bold, Centered)

As the author and creator of your article PDF, you have the most intimate knowledge of exactly what the PDF
should display. We ask allauthors to carefully check their article PDF prior to submission. Perform visual inspections
to detect subtle font errors and ensure that all fonts are embedded. With the wide range of tools and software that
authors use to create PDFs, and the number of devices and platforms that readers use to view/print them, font
embedding by authors is not only “nice-to-have”; it is essential.

Why Should I Care About Font Embedding? (Third Level Heading)
(Use the Microsoft Word template style: Heading 3) or (Times New Roman Font: 10 pt, Italic, Centered)

Embedding fonts into your PDF file is critically important for two reasons:

1. Commercial printing companies are unable to print PDFs without the correct fonts embedded.

2. Toensurethatyouronline article PDF file displays and prints correctly for everyone who wants to read your
work.

Readers of scientific articles use an ever-increasing range of devices and applications to access, view, and print
PDFs — from smart phones and tablets to desktop computers runningany one of a number of operating systems. To
ensure that readers of your article can display and print it correctly, it is important for your article’s PDF fik to be
truly portable: Your PDF file needs to be fully “self-contained.”

CONCLUSION
(Use the Microsoft Word template style: Heading 1) or (Use Times New Roman Font: 12 pt, Bold, ALL CAPS,
Centered)

In this section we welcome you to include a summary of the end results of your research. Font should be Times
New Roman, 10 pt.

ACKNOWLEDGMENTS
(Use the Microsoft Wordtemplate style: Heading 1) or (Use Times New Roman Font: 12 pt, Bold, ALL CAPS,
Centered)

If desired, in this section we welcome you to include thank your comments for those who have supported your
research. Font should be Times New Roman, 10 pt.



REFERENCES
(Use the Microsoft Wordtemplate style: Heading 1) or (Use Times New Roman Font: 12 pt, Bold, ALL CAPS,

Centered)

References should be numbered using Arabic numerals followed by a period (.) as shown below and should follow
the format in the below examples.

M. P. Brown and K. Austin, The New Physique (Publisher Name, Publisher City, 2005), pp. 25-30.

M. P. Brown and K. Austin, Appl. Phys. Letters 85, 2503-2504 (2004).

3.  R.T.Wang, “Title of Chapter,” in Classic Physiques, edited by R. B. Hamil (Publisher Name, Publisher City,
1999), pp. 212-213.

4. C.D.SmithandE.F. Jones, “Load-cyclingin cubic press,” in Shock Compression of Condensed Matter-2001,

AIP Conference Proceedings 620, edited by M. D. Furnish et al. (AlIP Publishing, Melville, NY, 2002), pp. 651—

654.

B. R. Jackson and T. Pitman, U.S. Patent No. 6,345,224 (8 July 2004)

D. L. Davids, “Recovery effects in binary aluminum alloys,” Ph.D. thesis, Harvard University, 1998.

R. C. Mikkelson (private communication).
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Where to Find Further Information
We warmly invite youto visit our online platform, Scitation, where you can find further help/advice and publishing

policies for AIP Conference Proceedings:

For authors: https://aip.scitation.org/apc/authors/preppapers
Forconference organizers: https://aip.scitation.org/apc/organizers/abstracts

Summary: Points to Consider when Preparing Your Paper
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Axrticles should use 8.5 x 11 single column template.

Use Times New Roman font, the point size will vary by section.

DO NOT alter the margins of our templates. They are carefully designed for AIP’s production process:
Altering them can cause significant delays. Paper size should be 8 %2 x 11 with marginssetat: Top— 1 inch,
Left — 1 inch, Bottom — 1.18 inch, Right — 1 inch.

DO NOT display the title in ALL CAPS (initial cap only)

DO NOT include any headers, footers, or page numbers in your document. They willbe addedto yourarticle
PDF by AIP Publishing, so please do not amend this template to add them to your paper.

Line spacing should be 1.0 throughout the entire article, no double spacing.

Makesure allauthor affiliation associations are correct. This means author vs. affiliationand author vs. email
address. If there is only one affiliation for all authors, association is not needed. Author names should be
listed in First name Surname format.

Use clear, legible graphicsand diagrams. Readers of your paper will be grateful. If they cannot read it, they
are unlikely to cite it.

DO NOT use copyrighted material without permission. Papers using copyrighted material without
appropriate permission and acknowledgment will be excluded from the proceedings.

No 1-page papers please. 1-page, abstract-only contributionsare not acceptable and will be excluded from
the proceedings.

Prepare and format references with care. References should be numbered using Arabic numerals followed by
a period (.).

Embed all fonts into your article PDF. The importance of font embedding is discussed in the section Font
Embedding (above). PDFs supplied without embedded fonts are often completely unusable for printing or
publicationpurposes. In such cases, we mustreturnthose PDFs to the proceedings editors for fontembedding.
Failure to embed fonts can cause unnecessary inconvenience to your proceedings editor(s) and publication
delays for other authors. Failure to provide a replacement paper in a timely fashion may result in an article
being removed from the proceedings.

Check yourarticle PDF file! It isnot uncommon for errors to appear in PDFs generated from Microsoft Word
— corrupted math, figures reflowing, etc. It is essential to very carefully check your article PDF file before
sending it to the proceedings editor(s).

Avoid large PDF files (10 MB maximum, ideally). For the benefit of your readers, we recommend keeping
your article PDF file below 10 MB. This is a recommendation, not a requirement.


https://aip.scitation.org/apc/authors/preppapers
https://aip.scitation.org/apc/organizers/abstracts

